
Journal of Theoretical and Applied Information Technology 
15th July 2017. Vol.95. No 13 

 © 2005 – ongoing  JATIT & LLS   

 

ISSN: 1992-8645                                                       www.jatit.org                                                          E-ISSN: 1817-3195  

 
3127 

 

IMPLEMENTING AN EFFICIENT EXPERT SYSTEM FOR 

SERVICES CENTER MANAGEMENT BY FUZZY LOGIC 

CONTROLLER 

 
1 
MOHD KHANAPI ABD GHANI,

 1,4 
MAZIN ABED MOHAMMED, 

2 
MOHAMMED S. IBRAHIM, 

3
 SALAMA A. MOSTAFA, 

2
DHEYAA AHMED IBRAHIM 

1
Biomedical Computing and Engineering Technologies (BIOCORE) Applied Research Group. Faculty of 

Information and Communication Technology, Universiti Teknikal Malaysia Melaka, Malaysia 
2 
Computer Science Department. College of Computer Science & Information Technology, University of 

Anbar, Iraq 
3
Faculty of Computer Science and Information Technology, Universiti Tun Hussein Onn, Johor, Malaysia 

4
Planning and Follow Up Department, University Headquarter, University of Anbar, Anbar, Iraq 

 

E-mail: 
1
 khanapi@utem.edu.my,

 1,4
 mazin_top_86@yahoo.com, 2 mohammad_alaubeedy@yahoo.com, 

3
semnah@yahoo.com, 

2
 dheyaa.ibrahim88@gmail.com   

 

 

ABSTRACT 

 

Expert System (ES) is considered to be the prominent reasoning practices which are commonly employed 

towards various application domains. Considering expert systems, human understanding regarding specific 

proficiency in accomplishing specific tasks could be signified as facts and rules towards their knowledge 

base, which finds and employs the data delivered by means of a manipulator. Reasoning procedure has been 

further employed towards the specified expertise by means of heuristic methods for formulating the 

elucidation. Mechanisms which employ knowledge based approaches are considered to be more candid 

when compared to other conservative approaches. Knowledge could be signified clearly towards 

knowledge base, thereby capable in alteration with comparative easiness, which commonly employs the 

concept of rules. Inference engines employ knowledge base subjects for solving specific problems based on 

user responses by means of interface (for instance, specify the situations needed for car assessment). This 

inference unit deeds with knowledge for applying this knowledge for specific problems. There are 

numerous approaches for control systems that are applied in all the major areas in industry. In all these 

approaches for controlling the systems, fuzzy has been deemed to be the best methodology, mainly because 

of its increased speed and cost-efficiency. For machine regulation, fuzzy logic is found to be vividly 

employed. This paper mainly focuses in designing the simulation model for fuzzy logic regulator in 

advising the supervisor of service center in maintaining definite delay in service towards acceptable limits 

to the customers by the usage of simulation package, the Fuzzy Logic Toolbox MATLAB Simulation tool. 

Keywords: Expert Systems, Artificial Intelligence, Services Center Management, Fuzzy Logics, 

Knowledge-Based Systems, Inference Engines. 

 

1. INTRODUCTION  

 

Expert Systems are one of the best methods 

which are typically employed in the assessment of 

application domains. Here, the expertise possessed 

by a human being in accomplishing specified tasks 

is enumerated as facts and rules at their knowledge 

bases [1], which commonly operates based on the 

data offered by users. In the specified knowledge, 

reasoning processes are carried out by means of 

heuristic methods in formulating solutions[2], [3]. 

ES could be defined as enumerated in [1] as: “An 

intelligent computer program that uses knowledge 

and inference procedures to solve problems that are 

difficult enough to require significant human 

expertise for their solution” [4]. This contains two 

peculiar sections: knowledge bases and inference 

engines, also possessing one knowledge acquisition 

module and one explanation module as additional 

modules. Figure 1 explains the articulation and 

main components of a typical expert system.  

Knowledge based approaches are typically 

upfront when compared to other conservative 

approaches. For altering with comparative easiness,  
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the knowledge shall be signified obviously at 

knowledge bases, which is done in the form of 

rules. 

 

Figure 1. Main Components Of ES [1]. 

Inference engines uses these contents in solving 

specific problems based on operator replies by 

means of interfaces (for instance, entering situations 

in car assessment). These inference modules deeds 

knowledge for applying them towards specified 

problems [1]. 

Problem explanation: One service center 

accumulates replacement portions, thereby repairs 

the disastrous parts. One purchaser carries damaged 

parts, thereby purchases parts of identical types. 

Subsequently, the damaged parts on being repaired 

becomes spares, and are placed on shelves. On 

purchasing the needed parts that are located on the 

shelf, the customer leaves the premise. But, in 

conditions when there is non-availability of spares, 

the customer waits till the spares arrive. Here, the 

main goal of fuzzy logic is towards advising the 

managers of service centers in maintaining the 

actual delay to be within acceptable limits by 

customers. 

For achieving the foremost objectives, this study 

concentrates on some specific tasks. To 

Understanding the overview and basic concepts 

about fuzzy logics. Fuzzy Logic Toolbox has some 

specified toolboxes that have to be understood 

clearly. There are no specified explanations, thereby 

this phase has to be well-versed in order to 

understand necessary processes. Constructing 

systems using Fuzzy Logic Toolbox encounter with 

the steps carried out in building or editing fuzzy 

systems by means of this toolbox. Constructing 

systems using Fuzzy Logic Controllers using Rule 

Viewer blocks by means of Simulink, thereby 

interconnects it with this toolbox. And the outcomes 

attained from simulation have to be evaluated. 

The process of summing up numerous rules will 

result in better solution. The venture shall discuss 

and analyze the results attained for verifying the 

items signified below: 

1. Execute these systems by means of 

dissimilar amounts of rules for proving that precise 

results could be attained in totaling more amount of 

rules. 

2. Numerous approaches and fuzzy 

membership functions have to be encountered for 

finding finest technique which is employed for 

attaining the best needed results. 

 

2. RESEARCH OBJECTIVES 
 

This anticipated research work performs the 

policy based approach of fuzzy logic controller at 

service center in advising the supervisor towards 

defining decision strategies for keeping their 

customers gratified. The following points represent 

the objectives of the research: 

• To integrate fuzzy logic and expert system in 

service center management model.  

• To implement the model via MATLAB 

Simulation tool. 

• To evaluate the performance of the 

simulation. 

3. RELATED WORKS 

Expert Systems are one of the best methods 

which are typically employed in the assessment of 

application domains. Aggarwal et al.[5], anticipated 

one basic approach for appraising the performance 

of IT staff-members in an organization. This 

approach is further elaborated in assessing their 

performance on the basis of serious issues that are 

dependent on their performance. Dissimilar 

superior specialists and human resource people 

were asked to structure the fuzzy rules for their 

fuzzy knowledge base, because it becomes 

mandatory to acquire knowledge from the experts. 

Furthermore, upon constructing these rules, 

different people at managerial level, human 

resource level and superior experts confirmed these 

rules.  Lastly, these outcomes are revealed towards 

them and their response were excellent.  The effort 

could be extended in familiarizing ambiguity 

attitude for dealing with these rules. 
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Roseline et al.[6], enumerated that there exist 

numerous practices existing in identifying diseases 

and evaluating their harshness, thereby approvals 

could be prepared on their basis, but the most 

frequently employed strategy is the knowledge of 

farmers and of agriculturists. Resultant ES created 

is of the mixture of the aforementioned issues 

together with the enumeration of technical 

developments. Therefore, novel type of diseases 

that attack the crops could be documented. This 

could also be expanded for incorporating several 

units such as combined pest administration, soil 

administration and fertilizer administration thereby 

creating it as a complete explanation earner, 

subsequently increases yielding. Gupta et al.[7], 

entailed an ES to categorize service providers for e-

governance service centers. Based on the 

information to be gotten by several case studies that 

are attained from service centers, the classes are 

derived towards these providers on the basis of 

demographic, knowledge and behavior 

characteristics. These expert systems shall be 

assigning service providers towards categories that 

are defined earlier and offers equivalent 

relationship standards assumed for these systems by 

means of fuzzy logics. Prototype has been 

deliberated in this paper to identify the service 

providers on the basis of demographic, knowledge 

and behavior characteristics. 

Shah et al.[8], enumerated a method to 

categorise the customer and customer service 

advisor (CSA) inside customer contact centre 

(CCC) atmosphere. Based on the information 

gathered by means of case-studies that are attained 

inside a CCC, two-step grouping examination 

inside SPSS has been employed in deriving classes 

for clients and consultants on the basis of 

demographic, knowledge, commercial worth and 

behaviour characteristics. This ES allocates fresh 

client or consultant towards the already defined 

classes and offers equivalent relationship standards. 

Authors have elucidated the stages that are needed 

towards the construction of this fuzzy ES. 

Prototype systems are created for identifying the 

category of clients and CSA on the basis of 

demographic, knowledge and behaviour 

characteristics. This approach has been 

authenticated inside the case study by means of 

simulation results. Kozhakhmet et al.[9], claimed 

the unmapped expanses and brighter associations to 

implement ES towards inspecting, creating fuzzy-

based information bases towards ES, incorporation 

of fuzzy quantities for developing endorsements   in 

security inspection, etc. Hypothetical implications 

in investigates are deliberated. This paper forms a 

part of entire systematic investigational methods 

and numerous problems to implement fuzzy logics 

towards data security inspecting and expansion of 

fuzzy ES, which is clear that these investigations 

are the best systematic and essential towards 

artificial intelligence domains.  

Zarandi et al.[10], anticipated one fuzzy rule-

based ES for evaluating the complete performance-

degree of intelligent investment, by which the 

supervisors could comprehend enterprise-situation 

for each items of intelligent investment even though 

they do not encompass precisely the meaning of 

each items, also understands whether every items 

are significant for decision-making. Furthermore, 

by means of linguistic terms for objects assessment 

results in precise decision. The latest anticipated 

method requested professionals about the 

performance gradation and reputation gradation of 

every intelligent investment items. By such 

manners, the risk faced is that the specialists do not 

possess strong idea regarding all items, thereby 

their assessment results with inaccuracy. Therefore, 

employment of fuzzy ES could assist specialists in 

improving their decisions to be beneficial. 

This work focuses on integrating fuzzy logic 

and expert system in service center management 

simulation. We intend to investigate different types 

of fuzzy rules and degrees of memberships. The 

aim is to improve the performance of the expert 

system in handling service center management.  

 

4. ESSCMFL PROTOTYPE MODELING   
 

A service center retains replacement portions and 

repairs the disastrous-ones. One client carries 

disastrous items and obtains spares of identical 

kind. Disastrous portions have been revamped, 

positioned on ledge, thereby becomes spare parts. 

The needed parts being obtainable from the shelf, 

the client buys it and returns from service center. 

Conversely, when spares are not available in the 

shelf, the client waits till the spare parts are ready. 

Fuzzy system here advises the supervisor in 

keeping actual delay in service within the limits the 

acceptable to customers. 

 

4.1 Fuzzy Logic 

Fuzzy Logic (FL) has been proposed by Lotfi 

Zadeh, instructor in University of California in 

Berkley as a hard customary involvement or non-

involvement [11], [12]. FL has not been employed 

for control system till 70's because of inadequate 

minor-computer competence. FL gets diversified 
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from other conservative techniques because of its 

simplicity and rule based IF X AND Y THEN Z 

style for resolving control problems than by 

endeavoring towards mathematical systems. This 

strategy is empirical-based and trusting on 

operator-experience rather than practical indulgent 

of systems [13]. For instance, to deal with 

temperature control in terms such as "SP =500F", 

"T <1000F", or "210C <TEMP <220C", terms like 

"IF (process is too cool) AND (process is getting 

colder) THEN (add heat to the process)" or "IF 

(process is too hot) AND (process is heating 

rapidly) THEN (cool the process quickly)" were 

employed. Five principal graphical user interface 

(GUI) tools are employed for constructing, 

elimination and detecting fuzzy inference systems 

in their toolbox: 

• Fuzzy Inference System-FIS Editor 

• Membership Function 

• Rule-Editor 

• Rule-Viewer 

These GUI were vigorously associated, the 

variations made to one toolbox effects in variations 

in other GUIs. The toolbox also comprises of 

graphical ANFIS Editor GUI that could be 

employed in constructing and examining Sugeno-

types adaptive neural fuzzy inference schemes as 

shown in figure 2. 

 

Figure 2. An articulation of FIS Systems 

  

4.4.1 FIS Editor  

This editor maintains high-level problems in 

the systems. FIS editor shows the overall data 

regarding fuzzy inference system. The figure 

illustrates the names of every input variables to be 

at left-side and outputs on right-side [14]. These 

subsequent steps reveal the processes involved in 

opening a FIS editor. 

 

1. For starting the systems from scrape, fuzzy 

has to be typed in the MATLAB prompt. 

2. Pick Edit > Add Variable > Input (in case the 

systems requiring three inputs). 

3. Tick yellow box input1, which has been tinted 

by means of red framework. 

4. Manage Name section from input1 to 

Mean_Delay, give Enter. 

5. Tick yellow box input2, which has been tinted 

by means of red framework. 

6. Manage Name field from input2 to 

Number_of_Server, give Enter. 

7. Tick yellow box input3, which has been tinted 

by means of red framework. 

8. Manage Name field from input3 to 

Utilisation_Factor, give Enter. 

9. Tick blue box output1. 

10. Manage Name field from output1 to 

No.Spares, give Enter. 

11. Pick File > Export > To workspace.section has 

to be in sentense case with no spacing  above 

or blow the srat of it as shown in figure 3.  

Figure 3. Pick File process 

 

12. Give Workspace variable name center, tick 

OK as shown in figure 4. 
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Figure 4. The FIS Editor Framework 

 

4.1.2 Membership Function 

The membership function editor parts few 

attributes towards FIS editor. It contracts the 

computer operator for displaying and editing all the 

membership functions related to every input 

variables and output variables towards the complete 

fuzzy inference scheme [15]. Steps in opening 

membership function editor has been entailed 

below. 
 

• Inside FIS editor windows, pick Edit > 

Membership functions. 

• Inside FIS editor, double-click blue icon 

referred as No.Spares. 

• In command line, to be typed as mfedit. 

Articulation of the Membership Function 

Editor and  Articulation of FIS Editor for 

Membership Function variableare shown in Figures 

5,6. 

 
Figure 5. Articulation of the Editor 

 
Figure 6. Articulation of FIS Editor for Membership 

Function variable 

This procedure of postulating input 

membership function for three input service 

center problem is enumerated by the subsequent 

steps [16]. 

 

1. Input variables and Mean_Delay are 

selected by double clicking them. Range 

and Display Range are set to vector [0 

0.7]. 

2. Remove All MFs has to be selected from 

Edit menu, to eliminate every prevailing 

Membership Functions from Membership 

Function Editor.  

3. Add MFs has to be selected from Edit 

menu and the window gets opened as 

displayed below. 

 

 
Figure 7. the Membership Function process 

 

4. "trimf" MF Type and three Number of 

MFs are chosen, thereby produces three 

trimf curves towards input variable 

Mean_Delay. 

5. The curve is clicked once with the left 

most hump. Alter the name of the curve as 

Very_Short. For adjusting the form of 

membership function, tick on the 

membership function. The anticipated 
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parameter params listing will be 

appearing. The three inputs of params 

signify standard deviation, center and end 

for the trimf curve. 

6. Subsequent to the editing of every values 

and adjusting the membership functions, 

the system appears analogous to the figure 

displayed below. 

 

 
 

Figure 8. The Membership Function 

 

4.1.3 Rule Editor 

To call for Rule Editor, click the Edit menu 

and Rules are selected, or rule edit is typed at the 

command line. 

 
Figure 9. Schematic diagram of a Rule Editor 

 

On the basis of descriptions of input variable 

and output variable enumerated within the FIS 

Editor, Rule Editor permits in constructing rule 

declarations routinely. From GUI: 

• Rules are created by choosing an item in every 

input variable and output variable box, single 

Connection item and ticking Add Rule. None 

can be chosen as one of the variable potentials 

for excluding that variable from a specified 

rule and select not under any variable name to 

contradict the related excellence. 

• Clicking Delete Rule will result in deletion of 

a rule. 

• Clicking Change rule will result in editing of a 

rule. 

• Entering an anticipated number between 0 and 

1 in Weight result in weight assessment of a 

rule. If weight is not needed to be specified, it 

is expected to be unity 1. 

 

4.1.4 Rule Viewer 

 

Rule Viewer displays the structure of the 

complete fuzzy inference procedure, which is based 

on fuzzy inference. Every rows are the rules and 

every columns are variables, and rule numbers were 

exhibited at left-side of every rows. For viewing 

rules at status lines, tick rule number [17]. To open 

Rule Viewer choose View menu and select Rules. 

 
 

Figure 10. Articulation of Rule Viewer 

 

5. RESULTS AND DISCUSSION 

Service center model implemented by 

employing Matlab Toolbox, which is a higher-

performance linguistic towards methodological 

calculation. This mixes calculation, imagining and 

software design at easier-to-employ atmosphere 

where difficulties and answers are articulated in 

acquainted scientific representation. This has been 

generally employed as a universal persistence 

instrument for system notion expansion. This 

research work deals towards non-expert operator 
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and advantage from humble and ingenious 

thoughts. When the user fails in computing quantity 

of spares required, this application offers the user-

advice on what should be done. The GUI executes 

as a communication instrument which interconnects 

users to the systems, thereby displaying the 

enquiries regarding delay and servers of Centre to 

be responded by users and displays equivalent 

outcomes. 

The Service Center was implemented 15 times 

with different inputs, and the system produced 

different output depending on the inputs that was 

entered by the user. Before introducing the 

computational results, we have introduced the 

interface of the system. The Service center interface 

provides faster access to the inputs and outputs plot, 

and also the general form of the system could be 

seen by clicking the "System" button. Also, the 

Rule Base of the system and Rule Viewer could be 

seen, relationships between the inputs and outputs 

could be tracked by clicking on their buttons. 

 
Table 1. Results of implementing 15 offers 

 

No 
Mean 

delay 

No. of 

Server 

Utility 

Factor 

No. of 

Spares 

Linguist 

output 

1. 0.600 0.400 0.500 0.548 Medium 

2. 0.200 0.100 0.100 0.330 Small 

3. 0.150 0.330 0.200 0.398 Very Small 

4. 0.569 0.714 0.900 0.805 Large 

5. 0.468 0.900 0.900 0.726 Rather Large 

6. 0.173 0.400 0.994 0.343 Small 

7. 0.600 0.260 0.340 0.489 Medium 

8. 0.308 0.367 0.259 0.348 Small 

9 0.650 0.700 0.840 0.820 Large 

10 0.570 0.670 0.840 0.748 Rather Large 

11 0.370 0.170 0.300 0.333 Small 

12 0.358 0.753 0.367 0.492 Medium 

13 0.670 0.670 0.801 0.752 Large 

14 0.130 0.030 0.078 0.262 Very Small 

15 0.150 0.660 0.480 0.426 Rather Small 

 

We introduce the relationships among inputs 

and outputs by using the surface viewer which is a 

tool provided by Matlab. This tool displays the 

relationships among inputs and outputs in 3-

diminsional surfaces.  

The relationships among Mean_Delay, 

Number_of_Server and Utilization_Factor with the 

Number of Spares output have been demonstrated 

in figures 11, 12, and 13 respectively. 

 
Figure 11. 3D association among Mean delay, Number of 

Server and Number of spares 

 

 
 

Figure 12. 3D association among Mean delay, Utilization 

Factor and Number of spares 

 

 
 

Figure 13. 3D association among Number of Servers, 

Utilization Factor and Number of spares 
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The Service Center was implemented 15 times 

with different inputs, and the system produced 

different output depending on the inputs that was 

entered by the user. Before introducing the 

computational results, we have introduced the 

interface of the system. The Service center interface 

provides faster access to the inputs and outputs plot, 

and also the general form of the system could be 

seen by clicking the "System" button. Also, the 

Rule Base of the system and Rule Viewer could be 

seen, relationships between the inputs and outputs 

could be tracked by clicking on their buttons. 

the possible application of the system is to 

give client or whatever other focus servicing system 

more successfully than the current system. The 

proposed system to help individuals and satisfy 

their prerequisites easily. This system comprised of 

components like giving client services information, 

set arrangements. The possible application of the 

system are restaurants, cafes, help desk services and 

customer center service. 

 

6. CONCLUSION 

In this paper, an efficient service centre expert 

system has been presented. This expert system has 

been tested using Matlab Toolbox. Fifteen runs 

have been achieved for different situations. From 

these runs, we could conclude that the system has 

shot its ability in resolving numerous service center 

issues. By this expert system, the manger will be 

able to select appropriate choice in fastest time, in 

this case the system will provide the following 

characteristics for the manager of service center 

such as Load balance: using this system there will 

be balancing in load and this will improve the 

performance of service center, Time management: 

there will be no wastage in time, the problems will 

be solved in reasonable time, Customer: the 

customer will be satisfied as the service will be 

presented in an appropriate manner, and 

Experience: the system can be updated to cover 

new changes in experiences with every new 

environments. 
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